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1. Lwu y quan trong

Sé tay st dung dién t& nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trwéde khi s dung man hinh. Sé tay
bao gdm nhirng théng tin va cac lwvu y
quan trong lién quan dén viéc st dung
man hinh.

Ché dd bao hanh cla Philips ap dung véi
didu kién la san phdm phai dwoc s dung
dang cach theo muc dich st dung, theo
cac huéng dan hoat déng cung véi viéc
xuét trinh hoa don géc hodc bién nhan
tién mat ghi ré ngay mua, t&n ngudi ban,
mau ma va ma sb san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

® canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay cé thé
khién nguwoi dung dé bi dién giat, gap cac
rGi ro vé dién va/hoac co hoc.

Hay doc va thuc hién theo cac huéng dan
sau khi két ndi va str dung man hinh may
tinh:

Hoat dong

+ Hay dat man hinh & khu vyc khéng cé
anh sang trye tiép ctia mat, anh sang
ric c6 cweng d6 manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh lau ngay trong maéi trwdng nay cé
thé khién cho man hinh bi bac mau va
héng.

«  Di chuyén moi db vat c6 thé roi vao
céac 16 théng gid ctia man hinh hodc
ngan can qua trinh lam mat thich hop
cla c4c thiét bj dién t&r bén trong man
hinh.

« Khéng bit kin cac 16 théng gio6 trén vé
man hinh.

«  Pam bao dat man hinh & gan noi cé
phich c&m va 6 cam dién.

« Néu tat man hinh bang cach rut cap
nguén hodc day dién DC, hay doi 6
giay trwde khi cdm cap ngudn hodc
day dién DC d& man hinh hoat déng
binh thwong.

« Hay ludn dung cap ngudn chuén duwoc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui ldong tham khao
muc Trung tdm thong tin tiéu dung
cham séc khach hang)

« Khéng dat man hinh & noi bi chan
dong hay va cham manh khi dang
hoat dong.

» Khdéng dap hoac lam roi man hinh khi
dang hoat dong hoéc khi di chuyén.

Bao duwdng

« D& man hinh khéng bj héng, khéng dé
nén qua manh lén mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chét
khung man hinh d& nhéc Ién; khong
nh&c man hinh bang cach d&t ban tay
hodc ngén tay Ién mat man hinh LCD.

R0t phich cdm man hinh néu ban khéng
dinh sr dung né trong th&i gian dai.

« Rt phich cdm man hinh néu ban can
lau chtii man hinh bng mét miéng
vai hoi wét. Ban c6 thé lau man hinh
b&ng vai kho khi da ngat dién. Tuy
nhién, dwng bao gi& dung dung moi
htru co, chang han nhw con hoac cac
chét 16ng c6 ngudn gbc tir amoniac dé
lau man hinh.

« Dé tranh nguy co bi dién giat hoac
héng vinh vién bé man hinh, khéng
dat man hinh & noi ¢6 bui, mwa, nwéc
hodc & noi qua &m wot.

« Né&u man hinh bi wét, hay lau né bang
vai kho cang sém cang tét.

« Néu chét la hodc nwéc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau d6 lau sach chét la hodc
nwéce rdi glri man hinh dén trung tam
bdo dudng.



« Khéng cét gi» hodc st dung man hinh
& noi cd ngudn nhiét, anh nang truc
tiép ho&c qua lanh.

« D& duy tri hoat dong t&i wu cia man
hinh va st dung né trong thoi gian dai,
hay dung man hinh & noi nam trong
gi&i han nhiét d6 va do 4m sau.

« Nhiét d9: 0-40°C 32-95°F
+ D06 &m: 20-80% RH

Thong tin quan trong vé Thir néng/Anh

bong ma.

e Luobn bat trinh bao vé man hinh
chuyén déng khi ban khéng st dung
man hinh. Luén bat &ng dung lam mai
man hinh dinh ky, néu khéng, man
hinh cta ban sé& hién thj nhirng noi
dung tinh khéng thay déi. Hién thi lién
tuc cac anh tinh trong mét thoi gian
dai c6 thé gay ra hién twong “anh th
néng”, con dwoc goi la “anh ao” hay
“anh bong ma”, trén man hinh cta
ban.

“Anh thir néng”, “Anh 40" hay “Anh
béng ma” la hién twong phd bién trong
cbéng nghé man hinh LCD. Trong hau
hét cac trwong hop, hién twong “anh
thtr nbng” hodc “anh 40" hay “anh
béng ma” sé& dan dan bién mét sau
mot thdi gian man hinh bi ngat dién.

® canh bao

Khéng thé bat anh bao vé& man hinh, hoac
trng dung cap nhat man hinh dinh ky cé
thé gay ra cac sw ¢ “thtr nong” hodc “anh
sau” hoac “anh bong ma” nghiém trong
vbn sé& khong bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khong
bao gdm trong chinh sach bao hanh cla
chung toi.

Dich vu

« Chinhan vién dich vu chuyén mon
m¢&i dwoc mé vo boc man hinh.

«  Né&u can moi tai liéu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai

dia phwong ban. (vui long tham khéo
chwong “Trung tdm thdng tin tiéu
dung”)

« D& biét thong tin v& viéc van chuyén,
vui I6ng tham khao muc “Théng sé ky
thuat”.

*+ Khéng dat man hinh trong xe hoi/cép
xe dwdi dnh nang truc tiép.

& Ghicha

Hay tham khao y kién cta k¥ thuat vién
dich vu néu man hinh khéng hoat dong
binh thwdng hodc néu ban khéng chic
phai thwe hién quy trinh nao khi da lam
theo cac hwdng dan hoat ddng néu trong
sb tay nay.

1.2 M6 ta biéu twong

Cac muc phu sau day mé ta cac quy woc
vé biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gbm
cac ghi chd, lwu y hodc canh bao. Ching
dwoc st dung nhw sau:

& Ghi chu

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét gidp ban tan
dung tbt hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac théng tin gitp
ban biét cach tranh dwoc sw ¢ héng hoc
tiém &n dbi véi phan clrng hodc mat div
lieu.

® canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém an va gitp ban biét cach tranh
dwoc sw cb do.

M6t s6 canh bao cé thé xuét hién & nhiéu
dinh dang va c6 thé khéng di kem mét
biéu twong. Trong nhirng trudng hop nay,



céach thirc trinh bay cu thé clia canh bao
doé dwoc quy dinh bdi co quan chlrc nang
lién quan.

1.3 Virt bé san pham va vat liéu
doéng goi

Thiét bj dién & dién tt bj virt b6-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://mwww.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai dat man hinh El Lipchandé ‘
1. Dé‘lt man hinh nam sap trén bé mét‘
mém min, c&n than dé tranh lam tray

2.1 Lap dat xwdc hodc hong man hinh.
2. Gén try dé git¥ vao man hinh cho dén
B Noi dung géi hang khi né khoéa vao thich hop.
Start

3. Gitr chan d& man hinh bang ca hai tay
va |ap chat chan dé vao tru dé.

VGA (tuy chon) DVI (tuy chon)



El Két néi véi PC

" PHILIPS
i

I

@ Dau vao ngudn dien AC

© Diu vao VGA

© Dau vao DVI-D (co6 sén cho cac mau
vira chon)

© Déau vao am thanh (c6 sén cho cac
mau vira chon)

© Khoa chdng trdm Kensington

Két néi véi PC

1. C&m chét cap ngudn vao mét sau cla
man hinh.

2. Tt may tinh va rat cap ngudn.

3. Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. Cam cap nguon cta may tinh va cap
nguon clia man hinh vao 6 cdm dién
gan dé.

5. Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El Mb ta mat trwéc cha san pham

( N

00000

Mau 196V4LA

54

AUTO/ W /A /o/; @fOK dl)
(7] (6] o O (2] (1)

Mau 196V4L
(5]
AUTO/ W /A /0/4\ @fOK (ll)
(7] (6] o 6 0 (1]
BAT va TAT ngudn man
1 .
o O hinh.
Truy nhdp menu OSD.
© (/0K |Xac nhan diéu chinh menu
OSD.
© 4« |Trdvé mirc OSD trudec.
©® & |Chinh d6 sang.
© | A V¥V Chinh menu OSD.
1l |Chinh am lwgng loa.
e 2 2
[ |DPa6i dinh dang hién thi.
©® | AUTO Tw dong chinh man hinh.




. Cai dat man hinh
E1 M6 ta menu Hién thi trén man hinh Menu OSD

Hién thi trén man hinh (OSD) Ia gi? Duéi day Ia tong quan vé co cau clia
Hién thi trén man hinh (OSD) la mét tinh ey Hien thi trén e ht'r?f" Bf.‘” i the
nang c6 & moi man hinh LCD ctia Philips. sw dung co cad nay fam thong fin tham
N6 cho phép ngudi dung didu chinh hoat khgo khi mt‘lon thwe hién cac diéu chinh
dong cia man hinh hogc chon cac chirc khac sau nay.

nang ctia man hinh tryc tiép thong qua

~ N 2 , % L2 N N Main menu Sub menu
mét ctra sO hwdng dan hién thj trén man
hinh. Mét giao dién hién thi trén man hinh
dé& str dung duoc thé hién nhu sau: - [ VGA
Mau 196V4LA: bV

(available for selective models)

i VGA .
<= Input SeEE————
i DvI . Picture Format —  Wide Screen, 4:3

B — Picture
3 et 5 Brightness — 0~100
- Contrast — 0~100
. SmartContrast —— On, Off

Stand-Alone — On, Off
— Audio

Mute — On, Off

(available for selective models)

Color Temperature — 6500K, 9300K
— Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English . Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, AL, Turkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
: |||||||;‘|| 100 [ Transparency — Off, 1,2,3,4
= 50 L— OSD Time Out —— 5s, 10s, 20s, 30s, 60s
SmartCol . off
3 Language ‘ L Sewwp — Auto
3 0SD Setting - — H. Position — 0~100
b : — V. Position — 0~100
— Phase — 0~100
, > N .n - — Clock — 0~100
Hwéng dan co ban va don gian vé cac o
nat dléu khlén — Resolution Notification — On, Off
Trong menu OSD minh hoa & trén, ban ¢ [ Reser — Yes,No
thé nhan ¥ A cac nat & g& mat trwdc cla L Information

man hinh dé di chuyén con trd va nhan nat
OK dé xac nhan Iwa chon hodc thay déi.



El Théng bao vé dé phan giai 2.3 Thao dé va chan dé
Man hinh nay dwoc thiét k& dé hoat déng

t6i wu véi d6 phan giai gbc 1a 1366 x 768 H Thao chan gé

@ 60 Hz. Khi dwgc chinh sang d6 phan Trwéc khi bat dau thao chan dé man

gidi khac, man hinh sé& hién thi mot théng hinh, hay thwc hién theo cac hwéng dan
bao: Dung 1366 x 768 @ 60 Hz dé dat két bén dwéi dé tranh moi thiét hai hay chan
qua tét nhét. thwong cé thé xay ra.

Ban c6 thé tt thdng bao hién thi d6 phan 1. Bat man hinh nam sap trén bé mat
giai gbc tr muc Setup (Cai dat) trong min, can than de tranh lam tray xwoc
menu OSD (Hién thj trén man hinh). hoac héng man hinh.

El Tinh ning vat ly
Nghiéng

2. An vao cac kep khéa dé thao chan dé
ra khai tru dé.




. Cai dat man hinh
& Note
This monitor accepts a 100mm x 100mm VESA-
Compliant mounting interface.

7
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100mm

100mm
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3. Toi wu héa hinh anh

3.1 SmartContrast

EH po1a gi?

Cbng nghé doc dao vén linh hoat phan
tich noi dung hién thi va tw déng téi wu
héa ty & twong phan ctia man hinh LCD
dé mang lai do ré nét va trai nghiém xem
tdi wu, tdng mrc dén nén dé hién thi
nhi*ng hinh anh sang ré hon, sic nét hon
va sbng dong hon hay gidam mdc dén nén
d& hién thi rd hinh anh trén phong nén téi.
E sao t6i phai can n6?

Ban muén hién thj ndi dung rd nét ciing
cadm giac thoai mai nhat khi xem moi loai
n6i dung. SmartContrast sé linh hoat chinh
do twong phan va mirc dén nén dé hién
thi nhirtng hinh anh choi game hay video
cwe rd, sbng déng va sac nét hay hién thj
ndi dung chiv rd rang dé doc cho céac rng
dung van phong. Bing cach giam viéc tiéu
thu dién cGa man hinh, ban sé tiét kiém
dwoc chi phi ndng lwong va kéo dai tudi
tho cho man hinh cta ban.

El cach hoat dong?

Khi ban bat ché d& SmartContrast, n6 sé
phan tich ndi dung dang hién thj trong
thwe t& dé chinh mau sac va mat do den
nén. Chirc nang nay sé linh hoat téng
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite m&i cla
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa 4o tién dung. Cac
diéu chinh phtrc tap la nhitng gi thudc

vé qué khir vi phan mém than thién voi
nguoi dung nay sé hwéng dan ban qua
viéc tuy chinh d¢ phéan gidi, hiéu chinh
mau, diéu chinh déng hd/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v...

Trang bi cdng nghé mai nhat vé thuat toan

I6i x& ly va phan (rng nhanh, phan mém

chay béng anh déng bt mat thwong thich

vé&i Windows 7 nay sé&n sang nang cao trai

nghiém cuta ban v&i man hinh Philips!

B cai aat

«  Thuwc hién theo chi dan va hoan tat quy
trinh cai dat.

+ Ban c6 thé kh&i ddng phdn mém sau
khi hoan tat cai dat.

«  Néu mubdn kh&i ddng sau, ban c6 thé
click phim tat phdn mém trén man hinh
nén hodc thanh céng cu may tinh.

PHILIPS e g ez

Monitor driver and software installation

Wizard (Thuat si) kh&i dong lan dau

+ Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé ty dong vao
Wizard (Thuat si) khéi déng lan dau.

» Thuat si nay s& hwdng dan ban théng
qua viéc diéu chinh tirng budc vé hiéu
suét man hinh.

+ Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat sT.

« Ban c¢6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.



. T6i wu héa hinh anh
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SmartControl Lite PHILIPS SmartControl Lite
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Menu Adjust (Diéu chinh) cho phép ‘
ban chinh Brightness (D6 sang),
Contrast (D6 twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (D6 phan giai).

Ban c6 thé 1am theo chi dan va thuc
hién diéu chinh.

Lénh Cancel (HUy) sé héi nguwdi dung
xem ho c6 mudn hay tién trinh cai dat
hay khéng.
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3. T6i wu héa hinh anh

[ Tewr—

SmartControl Lite

ggaA®

Menu Color (Mau):

*  Menu Color (Mau) cho phép ban chinh
mau RGB (Bd-Luc-Lam), Black Level

2-prien 22383 (coar1300803) ()%

PHILIPS

Resolution

(Do t6i), White Point (Biém tréng),
Color Calibration (Hiéu chinh mau).

« Ban c6 thé 1am theo chi dan va thuc

hién diéu chinh.

Tham thao bang bén dwéi dé hinh

dung co ban v& muc menu phu trén
théng tin nhap cua ban.

mau sic):
[

SmartControl Lite
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. T6i wu héa hinh anh

1.

“Show Me” (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

Start (Bat du) - bat dau quy trinh
canh chinh mau qua 6 budc.

Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

Tré vé giao dién chinh Color (Mau),
click nut Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khdéng chon muc nay, ban
khéng dwoc phép hiéu chinh mau va
tét cac nat khéi dong va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nt Previous (Trwéc) sé tat cho dén
khi man hinh mau th( hai bat 1én.
Next (K& tiép) s& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

Cuéi cling, vao giao dién File>Presets
(File>Cai san).

Nut Cancel (Hly) sé dong giao dién
nguwdi dung (Ul) va tré vé trang bd
sung.

12

Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (Ju tién) tr menu Options
(Tuy chon) sb xudng. Trén man hinh
khéng hé tro' twong thich véi chudn DDC/
Cl, chi c6 s8n cac thé Help (Tro gitp) va
Options (Tuy chon).

[ o 3P 2238 (C0TI8800001) 2%

SmartControl Lite PHILIPS

« Hién thi cac cai dat wu tién hién hanh.

« O viva chon sé& bat tinh nang nay. O
chon la nat bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé& dwoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (Da tét)
sé x6a SmartControl Lite khdi menu
thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thi cac tuy chon menu
cho Help (Tro giup), Technical Support
(H6 tro ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da t&t Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thj EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khéng
bat khi kh&i ddng hodc nam trong
khay tac vu. Cach duy nhét dé bat
SmartControl Lite la tlr phim t&t trén
man hinh nén hoéc tir file chwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i ddng sé hoat déng
khéng tai khi 6 nay khong dwgc chon
(Pa tat).

« Enable transparency mode (Bat ché
dé trong subt) (Windows 7, Vista, XP).
Mac dinh la 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé

chi hoat déng khi chon Input (Nhap) tt

menu Options (TUy chon) sé xudng. Trén
man hinh khéng hé tro twong thich voi
chuén DDC/CI, chi c6 sén cac thé Help

(Tro gitp) va Options (Tuy chon). TAt ca

cac thé SmartControl Lite khac déu khéng

co sén.
W St Pl 1738 13 fx

PHILIPS

= o
-

« Hién thi giao dién hu’c'rqg dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

e Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thi.
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Options>Audio (Tuy chon>Am thanh)
- Sé chi hoat dong khi chon Audio (Arp
tha'nh) tr menu Options (Tuy chon) s6
xuong.
Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi co sén cac thé
Help (Tro giup) va Options (Tuy chon).
P snartone Lo 18 x
SmartControl Lite PHILIPS

Audia

=

L 2
e

‘A

&

3
=

Help>User Manual (Tro’ giip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (S tay st dung) t menu Help
(Tro gitp) sb xubng. Trén man hinh khéng
hé tro twong thich véi chuan DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options

(Tuy chon).
SmartControl Lite PHILIPS

User Mana! 1

-1 L T TF



Help>Version (Tro’ giup>Phién ban) - S&
chi hoat dong khi chon Version (Phién
ban) t& menu Help (Tro gitp) s xudng.
Trén man hinh khéng hé tro' twong thich
v6i chudn DDC/CI, chi c6 sén cac thé
Help (Tro giup) va Options (Tuy chon).
SmartControl Lite PHILIPS

User Manua 1

it lele e ?5

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thuéc tinh) s& dwoc Bat. Néu
da chon Enable Context Menu (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

D SmartControl
Helect Preset L3
Tune Display

Menu Thudc tinh c6 ba muc nhép:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) s& hién thi.

» Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai san da
Iwu theo trinh tw dé st dung ngay.
DAu kiém sé& hién thi muc cai san hién
da chon. Muc Factory Preset (Cai sén
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gbc) ciing co thé dwoc chon tir menu
sO xudng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+  Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

¢ Help (Tro gidp) - Truy cap file User
Manual (SO tay si* dung): M¢ file User
Manual (S6 tay s dung) qua clra sb
trinh duyét mac dinh.

+  Technical Support (H6 tro kj thuat) -
hién thj trang hd tro' ky thuat.

«  Check for Update (Kiém tra cap nhat)
- dan nguwoi dung dén N&n (ng dung
PDI va kiém tra phién ban clia nguoi
diing so v&i phién ban co sén méi
nhét.

* About (V&) - Hién thi thong tin tham
khdo chi tiét: phién ban san pham,
thong tin vé phién ban va tén san
pham.

» Exit (Thoat) - Bong SmartControl Lite.

pé chay lai SmartControl Lite, hdy chon
SmartControl Lite ttr menu Program
(Chwong trinh), click déi biéu twong PC
trén man hinh nén hoac khai dong lai hé
théng.



. T6i wu héa hinh anh

PHILIPS
Smart!‘ trol

areion 320
dhune-standard-R2007-H -04-1151-23
Copyright 1963-2007 Portred Dueplays, .
Paipns Penaing

D4 tat menu khay tac vu

Khi da tat Khay tac vu trong thu muc

wu tién, chi con cé san lwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khéi khay tac vu, hay tét Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).

15



4. Cac thoéng sé ky thuat

Loai mat man hinh TFT-LCD

Deén nén LED

C& man hinh Rong 18,5 inch (47cm)
Hé sé co 16:9

Do pixel 0,3x0,3mm

Do sang 200 cd/m?

Do twong phan thong minh 10,000,000:1

Do twong phan (chuan) 600:1

Thoi gian dap (ng (chuén) 5ms

1366 x 768 @ 60Hz

Gobc xem

90° (H) / 65° (V) @ C/R > 10

Mau man hinh

16,7 triéu mau

DPau vao tin hiéu

Tbc d6 phat doc 56Hz - 76Hz
Tan s6 ngang 30kHz - 83kHz
SRGB (Pd-Luc-Lam chudn) | CO

DVI (KTS), VGA (Analog)

Tin hiéu vao

Tién ich cho ngu®i dung

Ddng bo riéng, Bdng bd véi tin hiéu xanh luc

196V4LA:

AuTO/vY (/A 0/ 4 /0K 0)
196V4L:

AUTO/VY  D/A 0/ 4 /0K 0)

Ngén ng OSD (Hién thj trén
man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Dlrc, Tiéng Tay Ban Nha,
Tiéng Y, Tiéng Nga, Tiéng Hoa Gian thé, Tiéng Bd Dao
Nha, Tiéng Thé Nhi Ky

Tién ich khac

Khbéa Kensington

Tuong thich voi chuan Plug
& Play (Cam vao la phat)

DDCI/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Nghiéng -5/+20
196V4LA:
Ché d6 bat 16,46W (chuan), 19,23W (t6i da)
Ché do ngt (chd) 0,5W
Tét 0,5W
Dén bao LED ngudn Ché dd bat: Ché dd Trang, Chd/Ngu: Tréng (nhap nhay)
B6 ngudn Thir néng, 100-240VAC, 50-60Hz
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196V4L:

Ché d6 bat 16,54W (chuan), 17,2W (t6i da)

Ché dd ngu (cho) 0,5W

Tat 0,5W

Dén bao LED ngudn Ché dd bat: Ché dd Trang, Chd/Ngu: Tréng (nhap nhay)
B6 ngudn Thtr néng, 100-240VAC, 50-60Hz

San pham kém theo dé gitr
(Rong x cao x day)

443 x 349 x 201 mm

San pham khong kem theo
dé gilr (Rdng x cao x day)

443 x 279 x 48 mm

San phdm kém theo dé gitv | 2,980kg(LED)
S?n -eham khéng kém theo 2,660kg(LED)
de gitv

San pham déng goi 3,964kg(LED)

binh gilra cac sy co)

Pham vi nhiét d6 (hoat déng) | 0 °C - 40 °C
Pham YI nhiét d6 (Khong 20 °C - 60 °C
hoat dong)

D6 &m twong dbi 20% - 80%
MTBF (Thoi lwvong trung 30.000 gio(LED)

Chi thi ROHS (Gi¢i han cac

Phé chuén theo quy dinh

Mau

chét gay hai) co

EPEAT Bac (www.epeat.net)

Thung dwng Co6 thé tai ché 100%

Cac chat cu thé Thung dwng 100% khéng chira PVC BFR
Energy Star co

CE Mark, FCC Class B, GOST, SEMKO, BSMI, UL/cUL,
1S09241-307

Pen

L&p son ngoai

Bong lang/Hoa van

& Ghichu

1. Vang hay bac EPEAT chi c6 hiéu lwc tai noi ma Philips da dang ky san pham. Hay truy
cap www.epeat.net dé biét fnh trang dang kw tai qudc gia ctia ban.

2. D@ liéu nay chiu su thay d6i ma khoéng can théng bao trwéde. Truy cap www.philips.com/
support dé tai vé phién ban td roi méi nhét.
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4.1 Ché do do phan giai & cai
dit san

El 6 phan giai téi da
1366 x 768 @ 60 Hz (d4u vao analog)
1366 x 768 @ 60 Hz (d4u vao KTS)

E1 D6 phan giai khuyén ding
1366 x 768 @ 60 Hz (dAu vao KTS)

3147 720 x 400 7009
3147 640 x 480 59.94
35 640 x 480 66.67
37.86 640 x 480 72.81
375 640 x 480 75
37.88 800 x 600 60.32
46,88 800 x 600 75
4836 1024 x 768 60
60.02 1024 x 768 7503
4477 1280 x 720 59.86
63.89 1280 x 1024 60.02
79.98 1280 x 1024 7503
4771 1366 x 768 59.79
& Ghi cha

Lwu y rdng man hinh clia ban hoat déng
tbt nhat & do phan giai gbc 1366 x 768 @
60Hz. D& c6 chét lwong hién thi tot nhéat,
hay dung dé phan giai khuyén nghi nay.
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5. Quan ly ngudn dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw dong giam
tiéu thu dién khi khéng str dung. Néu phat
hién nhap tir ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat dong” tw
déng. Bang sau day sé hién thi mc tiéu
thu dién va cach truyén tin hiéu cla tinh
nang tiét kiem dién tw dong nay:

196V4LA:

Ché do - Pdng bd| Bdng | Ngudn dién | Mau dén
VESA ngang | b6 doc str dung LED
A . p 16,46W 2
Hoat dong| BAT Cé Co (chuén) Trang
£ 1 Tréng
Che dd | 14T | Knong | Khong [0,5W (chudn)| (Nhép
ngu (cho) =
nhay)
Tét TAT - - |0,5W (chudn)| TAT
196VA4L:
Ché do Video DPdng bd| Bbdng | Nguén dién | Mau dén
VESA ngang | b6 doc st dung LED
N A . . 16,54W <
Hoat déng| BAT Co Co (chuin) Trang
P Tréng
Che do | 147 | Kneng | Khang | 0,5W (chudn)| (Nhép
ngu (cho) nhéy)
Tét TAT - - |0,5W (chuan)| TAT

Cai dat sau day dwoc dung dé do murc

tiéu thu dién trén man hinh.

« Do phan giai gbc: 1366 x 768

+ Do twong phan: 50%

* Do sang: 200 nit

* Nhiét d6 mau: 6500k Vi kiéu mau
trang day du

& Ghichu

D@ liéu nay chiu sw thay ddi ma khéng

can thdng bao truorc.
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery

B and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

The EPEAT (Electronic
2, p .
Q roduct Environmental
N Assessment Tool) program

evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

» EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

* EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on ISO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

* MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we

; , have determined that this product

meets the ENERGY STAR?
guidelines for energy efficiency.

& Note



We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

6 Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Thong tin quy din

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

*  Augmenter la distance entre 'équipement
et le récepteur.

* Brancher I'€quipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic
Only)

This device belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it ia a Class A devics on the spscification labsl. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The usar of the
davics i ohiiged to take all stapa necassary to temove sources of intarfersnce io tels-
communication or ather devicss.

Fokud neni na typovém Stitku poSitade uvedeno, 28 spadd do do tfidy A podie EN 55022,
spadd automaticky do ffidy B podle EN 55022, Pro zafizenl zafazend do tidy A (chranné
pésma 30m) podie EN E5022 plati ndsleduicl Dojde-li k rulien! telekomunikadnich nebo
Jjch zafizani je utivatel povinnen provést takovd opatignl, aby nseni odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Uzadetic powinno byé zasitane # priagds 2 preytaceanyen obwoden ochronym (znisedo 2
Katkiem). Wapdlpracugace 2 sobg urzadzesia (Komputer, monstor, drukarka) powiniy byé zsilose
2 1epo samego dridla.

Instalacja elektrycma pomiesscrenia powinm mwiemé w przewoise Ezowym rezeraaws ochrang
precel wazciami, w pestaci berpiecentki o wirtodel mamionawe me wicksze] iz 184 (amperiw).
W celu calkowitego wylacamia ursdrenia i sleci zasilania, naleiy wylat wivezkg kabla
aasilancege 2 iinzdks, Ldre powinno 2 Jowad sus ' pobliz uezadToenia § byé o dostipie.
Faak beaplocarharwa "B” potwiordzs 2podendd urzsdzenis » wymaganianl bezplecasisiug
ueytkowania zawartymi w PN-S3T-42107 § PN-BAE46251

Pozostale instrukcje begpieczensiwa

Nie mley uzywad wiyceek sdapterowych Tub usuwaé kotka abwodu ochrannego 2 wiyeeki.,
el komsoczne jest utyese peacdiutacza to naledy uyé proediuzaces 3-sylowega 2
I )

¢ sii. aby nie nie lezato na ksblach systeru komputerowego, araz aby kable nie
sdzse midna byloby na nhe nadeptywad lub porykad slg o wie.

* Nie ey ol plymi s systoms Kooy

puterwy pawiisien Fnajdowad sig 2 dala od gracaikbo i nidel lepl. Porssdra
kecrwai atwordw wentylacyjych. Nakeiy anikat kadeenia lainych paperiow pod
karmpuler oriz umieszezanss karmpatera v cinsmym migjse ber mailiweic cyrkulacyi powi-
etz wokl nisgo




North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)
RAZHERERIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfilit sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy din

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

&Note
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham sé6c
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh
man hinh phang cua Philips
Philips cb gang cung cap cac san phdm
chét lwgng cao nhét. Ching t6i ap dung
mot s quy trinh san xuat tién tién nhat
trong Iinh vuc va thwe hién quy trinh kiém
tra chat lwong nghiém ngat. Tuy nhién, cac
I6i diém &nh hay diém anh con trén man
hinh TFT dung trong cac man hinh phéng
dai khi khéng thé tranh khéi. Khong nha
san xuét nao c6 thé dam bao rdng moi man
hinh s& khong co cac 16i diém &nh, nhung
Philips dam bao rang bat ky man hinh nao
c6 mdt sb 16i khong thé chap nhan sé duoc
slra chi*a hodc thay méi dwa vao chinh
sach bao hanh. Thong bao nay giai thich
nhirng kiéu I6i diém anh khac nhau va dinh
nghta cac mirc 16 cé thé chap nhan cho
m6i kiéu I6i. D& hudng dich vu stva chiva
hay thay thé theo chinh sach bao hanh, s6
lwong 16i diém &nh trén man hinh TFT phai
vurot qua cac mirc chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bj 16i. Ngoai ra, Philips tham
con dat ra cac tiéu chuén chét lwgng cao
hon cho mét s6 kidu hay két hcrp 16i diém
anh vén d& nhin thay hon cac kiéu 16 khac.
Chinh sach nay cé hiéu lyc trén toan cau.

diém  diém  diém
anh phu anh phu anh phu

H H ?
ey

DPiém anh va diém anh con

Diém anh hay phan t& anh gém ba diém
anh con trong cac mau chinh dé, luc va
lam. Nhiéu diém &nh ciing tao thanh hinh
anh. Khi moi diém &nh con clia mot diém
anh sang Ién, ba diém anh con cé mau sac
cting hién thi nhw mot diém anh trang don
1&. Khi moi diém anh con tdi mo, ba diém

anh con c6 mau sac cuing hién thi nhw mot
diém anh den don 1&. Nhirng két hop diém
anh con sang va toi khac hién thi nhw cac
diém anh don 18 tir nhixng mau khac.

Cac kiéu 16i diém anh

Céc 16i diém &nh va diém &nh con hién thi
trén man hinh theo nhirng cach khéc nhau.
C6 hai kiéu 16i diém &nh va nhiéu I6i diém
anh con trong méi kiéu 16i.

Cac 16i cham sang

Céc 16i chdm sang hién thi duoi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghta la méi chdm sang la mét
diém anh con vén ndi I&n trén man hinh khi
man hinh hién thj kiéu hinh t&i mo. Cé cac
kidu 16i chdm sang.

Mét diém &nh con sang dd, luc hay lam.

1 ¢

Hai didm anh con sang gan nhau:
bé + Lam =Tim
Dé + Luc = Vang

Luc + Lam = Luc lam (Lam nhat)




Ba diém anh con sang gan nhau (mét diém
anh trng).

& Ghi chu

Chém sang dé hay lam phai sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so Vo
cac chdm xung quanh.

Cac 16i cham den

Cac 16i chdm den hién thj dwéi dang cac
diém anh hay diém anh con vén ludn téi
m& hay “tat”. Nghia 1a méi cham tbi mo
Ia mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 céac kiéu 16i chdm den.

Do gan cua cac 16i diém anh

Vi céc 16i diém anh va diém &nh con cla
cuing kiéu 16 vén gan véi mot kiéu 16i khac
c6 thé dé nhin thdy hon, Philips ciing néu
ré cac dung sai vé d6 gan cda 16i diém anh

Dung sai 16i diém anh

D& huwéng dich vu stra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
didm &nh con vwot qué nhivng dung sai
néu trong cac bang sau.

A A F AP NHA
1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh trdng) 0
Khoang cach gitva hai I6i chdm sang* >15mm
Tbng sb 16i cham sang clia moi kiéu 16i 3

O A H) AP A
1 diém anh con t6i mo 5 ho&c it hon
2 diém anh con tdi md gan nhau 2 hodc it hon
3 diém anh con t6i m& gan nhau 0
Khodang cach gitva hai I6i chdm den* >15mm
Tbng sb 16i cham den ctia moi kiéu I8i 5 hoac it hon

TONG SO LOI CHAM

MUC CHAP NHAN

Tbng sb 16i chAm sang hay den ctia moi kiéu 6i

5 hoac it hon

& Ghi chi

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm

2. Man hinh nay tuan thd chuan 1S09241-307. (1IS09241-307: Yé&u ciu, phan tich v& hiéu
nang va cac phwong phap kiém tra tuan thd cho man hinh dién tt)

3. 1509241-307 la tiéu chuén tiép theo clia tiéu chudn 1SO13406 cii, vén @4 bi hly bo boi
T4 chtre Tiéu chudn hoa Quéc té (ISO) vao ngay: 13-11-2008.



7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 thdng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vire clia ban, vui long truy cap website www.philips.com/support. Bgn cling c6 thé lién
hé v&i Trung tdm cham soc khach hang dia phwong cda Philips theo sb dién thoai dwdi
day.

Théng tin lién lac cho khu vire TAY AU:

Qubc gia ASC (Trung tam  S6 cham séc khach

dich vu Gy quyén) hang

Germany Siemens 1&S +49 01803 386 853 €0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Quéc gia Trung tdm

dich vu

Théng tin lién lac cho khu viec TRUNG VA DONG AU:
ASC (Trung tdm dich vu

uy quyen)

S6 chiam séc khach hang

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
I\S/I?)r:tlsnigro NA Kim Tec d.o.0. +381 1120 70 684
Slovenia NA PC H.and +386 1 530 08 24
- NA Comel +380 562320045
NA Topaz-Service Company |+38 044 245 73 31
Russia NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. [NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary -
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:

Qubc gia

Brazil

Vermont

Argentina

Trung tam dich vu

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Québc

Sb cham soc khach hang: 4008 800 008

Théng tin lién lac cho khu viec NAM MY:

Quéc gia Trung tam 8 ASCUTrungitam dichivus e 5 icpamie 6e khach hang
dich vu uy quyen)

U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu viec Chau A TBD/Trung Dong/Chau Phi (APMEA):

Qubc gia

ASC (Trung tam dich vu

Uy quyén)

S6 cham séc khach hang

(warranty buy-out)

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika | Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices | FETEC.CO 0800-231-099
Taiwan
Thailand | NA ﬁ’;‘s Computer System Co., | 5671 934-5498
South Africa | NA f?’d'vara Technologies Pty | g6 0000 888
Uaned Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LL.C
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA (F:ErTnS:r':"'fj d'”format'c +84 5113.562666 Danang City
pany Lid. +84 5113562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA Sgtl;rce Ltd (warranty buy- 880-0-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 077-1-4229395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992
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8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw cd vén nguoi
dung cé thé khéc phuc. Néu sw cb van
tiép dién sau khi ban da thir dung céac giai
phéap trén trang nay, hay lién hé v&i dai
dién dich vu khach hang cta Philips.

E Cac sw cb thweng gip

Khéng c6 hinh anh (Pén LED nguén

khéng sang) .

«  Dam bao d& cam day ngudn vao 6
cam dién va mat sau clia man hinh.

«  Trwéc tién, dam bao nut ngudn &
mét tredc man hinh ndm & vi tri OFF
(TAT), sau d6 ddy nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Bén LED ngu6n

sang trang)

*  Dam bao da bat may tinh.

«  Dam bao cap tin hiéu da dwoc két nbi
dang cach véi may tinh clta ban.

*  Dam bdo cap man hinh khéng c6 cac
chéu cam bj cong trén mét két nbi.
Néu co, hay stra hay thay méi cap.

«  C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh théong bao

Attention

Check cable connection

+ Dam bao cap man hinh da duoc két
ndi dung cach v&i may tinh cta ban.
(Ciing tham khao Huéng dan khai
déng nhanh).

+  Kiém tra xem cap man hinh cé cac
chau cdm bj cong hay khéng.

*  DPam bao da bat may tinh.
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Nut AUTO (Tw dong) khong hoat dong

« Chuc néng tw dong chi ap dung & ché
dd VGA- Analog. Néu khéng hai long
voi két qua, ban co thé thuc hién cac
didu chinh tha céng qua menu OSD
(hién thj trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khong ap dung
& ché d6 DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

+ Khéng thwe hién bat ky buwéc khic
phuc sw cb nao

+  Ngét ngay két ndi man hinh khai &
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang cua Philips.

B cac swcé hinh anh

Hinh anh khéng ndm giiva tam man

hinh

* Chinh vj tri hinh anh qua chlrc nang
“Auto (Tw ddng)” trong cac nut diéu
khién chinh trén menu OSD.

e Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/Bdng hd) cliia Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi co6 hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chat ding cach vao bang mach
dd hoa hay may tinh hay chwa.

Hién thi hién twong chap chon doc

* Chinh hinh anh qua chirc nang “Auto
(Tw dong)” trong cac nat didu khién
chinh cdia menu OSD.



» Loai bé cac vach doc qua Phase/
Clock (Goc pha/Ddng hd) ctia Setup
(Cai dat) trong cac nat diéu khién
chinh ctiia menu OSD. N6 chi co6 hiéu
lwc & ché dd VGA.

Hién thij hién twong chap chon ngang

= —
—_—

* Chinh hinh &nh qua chc nang “Auto
(Tw doéng)” trong cac nuat diéu khién
chinh ctia menu OSD.

* Loai bd céac vach doc qua Phase/
Clock (Géc pha/Ddng hd) ctia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwc & ché dd VGA.

Hinh anh hién thi nhoe, khéng ré hodc

qua mo

* Chinh d6 twong phan va do sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

« Hién thi lién tuc cac anh tinh trong mot
thoi gian dai co thé gay ra hién twong
“anh thr néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
ctia ban. “Anh th&» néng”, “Anh 30
hay “Anh béng ma” 1a hién twong phé
bién trong cong nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r nobng” hodc “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh
chuyén ddng khi ban khoéng str dung
man hinh.

e Lubn bat (rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cda ban sé hién thi nhirng ndi dung
tinh khong thay déi.
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» Cac hién twong “anh thir néng” hay
“anh ao0” hay “anh béng ma” sé khéng
biét mat va ban can mang man hinh
di stra. Thiét hai nhw trén khéng ndm
trong chinh sach bao hanh cla ching
toi.

Hinh hién thi bién dang. Van ban bi m&

hoac nhoe.

» Cai d6 phan giai man hinh may tinh
sang cung ché dd véi do phan giai
man hinh géc khuyén dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thj trén man hinh

+ Céc chadm con lai la d3c tinh théng
thweng clia man hinh tinh thé 16ng
dung trong céng nghé ngay nay. Vui
ldng tham khao chinh sach diém anh
dé biét thém thong tin.

Pén “bat ngudn” qua sang va gay chéi

mat

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED ngudn trong cac nut
didu khién chinh ctia menu OSD.

DPé dwoc tro gitp thém, hay xem danh
sach Trung tdm thdng tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang cta Philips.



8.2 Héi bap chung

H1:

Khi cai cai dit man hinh, t6i cin
lam gi néu man hinh hién thi
“Cannot display this video mode”
(Khong thé hién thi ché d6 video
nay)?

Dap: Do phan giai khuyén ding cho man

hinh nay la: 1366 x 768 @60 Hz.
Ngat tAt ca cac cap roi két nbi PC véi
man hinh ma ban da dung trwéc dé.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang diéu
khién). Trong Control Panel Window
(Ctra s6 bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang mirc
1366 x 768 pixels.
Mé& thé “Advanced Properties” (Thuéc
tinh nang cao) va cai Mtrc cap nhat
(Refresh Rate) sang 60Hz réi click
OK.
Khéi dong lai may tinh va lap lai bwéc

2 va 3 dé kiém tra xem PC cla ban da

dwoc cai sang mirc 1366 x 768 @60
Hz hay chua.

Tat may tinh, ngét két ndi man hinh
cii va két ndi lai man hinh LCD Philips
clia ban.

T4t man hinh réi bat lai PC.

H2: Mdrc cap nhat khuyén dung cho

bap:

man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD 1a 60Hz. Néu c6 bét ctr
hién twong nhiéu nao trén man hinh,
ban cé thé cai dat mirc nay sang
75Hz @& kiém tra xem mirc méi nay
c6 loai bd duwoc hién twong nhiéu
hay khong.
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H3:

Pap:

H4:

bap:

H5:

bap:

He6:

bap:

H7:

Cac file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dat cac
driver (.inf va .icm)?

Day la cac file driver cho man hinh
cla ban. Thwc hién theo cac chi dan
trong s tay st dung dé& cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) ho&c 1&p dia driver khi ban
cai dat man hinh 1&n dau. Thyc hién
theo cac chi dan dé Iap (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat ty dong.

Lam thé nao dé chinh do phan giai?
Card video/driver dd hoa cla ban
va man hinh sé ciing quyét dinh

cac do phan giai c6 san. Ban co thé
chon dd phan giai mong mudn trong
Control Panel (Bang diéu khién)
clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).
Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK rdi chon
“Reset” (Cai dat lai) dé phuc héi moi
cai d&t mac dinh gbc.

Man hinh LCD c6 kha ning chéng
tray xwérc?

N6i chung ban khéng nén dé bé mét
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khai cac
vat dung séc hay cun. Khi cdm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Diéu nay cé thé anh hwéng
dén cac diéu kién bao hanh cta ban.

T6i nén lau man hinh LCD nhw thé
nao?

: D& lau thong thwong, hay st dung

khan sach va mém. Bé lau ky, hay
duing con isopropyl. Khéng ding
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...



H8: T6i c6 thé thay déi cai dit mau
sac cho man hinh?
DPap: DI nhién, ban cé thé thay dbi cai

dat mau sac qua nut didu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

. Nhén “Down Arrow” (Mdii tén
xudng) @& chon tuy chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhuw sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gdm 6500K va 9300K.
V&i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng
vé&i tin hiéu mau dé-tréng", trong khi
nhiét do 9300K tao ra “mat va&i tin
hiéu mau lam-tréng”.

2. sRGB (Pd-Luc-Lam chuén); day
la cai d&t chudn dé& dam bao trao
ddi mau thich hop gitra cac thiét bj
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); ngwoi dung
¢6 thé tw chon cai dat mau sac wu
tién bang cach chinh mau dé, luc va
lam.

& Ghichu

Do mau anh sang téa ra ttr mét vat dung

trong khi né dwoc lam néng. Sé do nay
dwoc thé hién dwa trén ty 1& tuyét déi, (mic

dd Kelvin). Cac mirc nhiét dé Kevin thap

hon nhw 2004K la mau dé; cac mirc nhiét

dd cao hon nhw 9300K |a mau lam. Nhiét

dé trung tinh 1a mau trdng & mirc 6504K.

H9: Téi c6 thé két néi man hinh LCD
vé&i moi PC, may cha hay may
Mac?

Co thé. TAt ca cac man hinh LCD
Philips déu hoan toan twong thich
v&i cac PC, may Mac va may ch
chuan. Ban c6 thé can co dau noi
cap dé két néi man hinh méi hé
thédng may Mac. Vui long lién hé voi
nhan vién kinh doanh cta Philips dé
biét thém thong tin.

bap:
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H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cam vao la

phat)?

C6, cac man hinh Philips d&u hd tro
chuén Plug-and-Play twong thich
v&i Windows 7/Vista/XP/NT, Mac
OSX, Linux

bap:

H11: Anh chap chén hay anh thir néng
hay anh ao hay anh bong ma trén
man hinh LCD la gi?

Hién thi lién tuc cac &nh tinh trong
mot thoi gian dai cé thé gay ra hién
twong “anh th&r nong”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cla ban. “Anh tht
néng”, “Anh do0” hay “Anh bong ma”
la hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
trwo'ng hop, hién twong “anh thir
néng” hay “anh ao” hay “anh boéng
ma” sé& bién mét dan trong mot thoi
gian sau khi da tat ngudn.

Lubn bat trinh bao vé man hinh
chuyén dong khi ban khéng st
dung man hinh.

Lubn bat rng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cta ban sé& hién thi nhirng ndi
dung tinh khéng thay dbi.

O canh bao

Khéng thé bat anh bao vé man hinh, hoac
trng dung cap nhat man hinh dinh ky c6
thé gay ra cac suw c6 “thtr néng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
vbn sé& khong bién mét va ciing khéng

thé khac phuc. Thiét hai viva néu khéng
bao gbm trong chinh sach bao hanh cla
chung téi.

Dap:

H12: Tai sao man hinh cua téi hién thj
van ban sac nét va cac ky tw ring
cwa?

Man hinh LCD cta ban hoat dong
tbt nhat & do phan giai gbc 1366 x
768 @ 60 Hz. D& man hinh hién thi
tdt nhét, vui ldng st dung dé phan
gidi nay.

bap:
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